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1  Please observe the following 

  

For safe and successful operation of the unit, read these instructions completely. The 
manufacturer cannot be held responsible for damage or injury of any kind because of misuse or 
improper application or because of failure to observe safety instructions or warnings. 
Be sure to retain this manual for future reference. 

1.1  Emphasized Sections 

   Warning! 
Refers to safety regulations and requires safety measures that protect the operator or other 
persons from injury or danger to life. 

   
   

   Caution! 
Emphasizes what must be done or avoided so that the unit or other property 
is not damaged. 

   

   Notice 
Gives recommendations for better handling or adjustment of the unit during operation as well as 
for service activities. 

1.2  Items Supplied 
  1 EQ PR10.1 DLP 3D Printer 

1 Base Frame or Cabinet 

1 Safety Basin 

1 Starter kit – Including: 

• 1 Spatula 

• 1 Resin Puller 

• 1 Resin Curing Flash Light 

• 1 Resin Basin 

• 1 Build Platform 

• 1 Nitrile Gloves 

• 1 Spray bottle 

• 1 Funnel with filter  

1 Operating Manual 

1 PC Software on USB flash drive. 

1 Power cord 

1 Lens Cap 

   Notice 
Illustrations and descriptions in this instruction manual can deviate in detail from the actual unit 
delivered, due to ongoing upgrades. 

1.3  Field of Application (Intended Usage) 
  The Loctite PR10.1 DLP 3D Printer is designed for use with Loctite 3DP resins.  

The Loctite PR10.1 can print parts with complex geometries which would be impossible using 
traditional manufacturing techniques.   



5 

 

1  Please observe the following 

1.4  For Your Safety 
  Request the technical data sheet and the safety data sheet for the LOCTITE® product used at 

www.loctite.com. 

FOLLOW UNCONDITIONALLY THE INSTRUCTIONS OF THESE DATA SHEETS! 

   WARNING! 
For safe and successful operation of the unit, read these instructions completely. 
If the instructions are not observed, the manufacturer can assume no responsibility. 

Removing, bypassing or putting out of operation safety devices can result in damage to persons 
and damage to the unit and is therefore prohibited! 

Damage to the power cord or the housing can result in contact with live electrical parts. Check 
the power cord and the unit before each use. If the power cord or the unit is damaged, do not 
operate! Replace a damaged power cord with a new one. 

The unit may be opened and repaired only by authorized service personal. 

Avoid contact with chemicals and wear protective clothing, gloves and goggles. 

Do not look directly at Projector-UV light, or at projector-UV light reflected by a reflective 
surface. Doing so could cause eye damage.  

Always wear UV blocking eye protection when operating this machine. 

Never operate this product any way other than described in this manual. Doing so risks exposure 
to LED-UV light. 

Any defects found must be reported immediately! Remedy any defects immediately! 

Use only original replacement and spare parts. Henkel cannot be held responsible for damage or 
injury of any kind because of failure to observe the instructions in this Operating Manual. 

Mechanical parts are moving slowly but with high forces and rigidity. Keep hands out of the 
printer when the axis in moving. 

The printer is a tall and heavy part. Make sure it stands well and cannot fall over. Take care when 
installing or transporting it. Make sure it is well fixated on the base cabinet with the included 
screws.      

 

  

http://www.loctite.com/
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2  Technical Data 

   

  Power supply 110 V AC 60 Hz - 240 V AC 50 Hz  

  Projector Full HD 1920 x 1080 pixels 

  Build Volume W x D x H 192mm x 108mm x 250 mm 

  Print Resolution X and Y Axis 100µm 

  Print Resolution Z axis 
(Layer Thickness) 

12 µm - 100 µm 
Resin dependent 

  Overall Dimensions W x D x H (mm) 490 x 420 x 1700  

  Weight Approx. 56 kg 

  Optimal Operating Temperature  22° C (71°F) 

  Build Platform Anodized aluminum 

   Resin Basin Exchangeable basin glass bottom coated with ultra-high 
chemical resistance PTFE.  

 
 

    

3  Description 

3.1  Theory of Operation 
  The operator loads resin into the resin basin and selects a print job which has been prepared on 

the supplied printer PC software.  The software requires a Windows 10 operating system.  

 

The build platform then lowers into the resin and the projector projects an image of the part 
layer by layer as the build platform is raised to create a complete part. 

 

Once the print is completed the operator removes the build platform from the printer and the 
printed part is detached from the build platform. 
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3  Description 

3.2  Machine Overview 
  

 

  1  Protective Cover (UV blocking)  

  2  Build Platform 

  3  Resin Basin 

  4  Touch Screen 

  5  On/Off Switch – located on the underside of the touch screen. 

  6  DLP Projector Housing 

  7  Storage Cabinet 

  8  USB Connection – located on the right-hand side of the touch screen. 

1 
 
2 
 
3 
 
4 
 
5 
 
6 
 
7 

 
 
 

8 
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3.3  Machine Connections 
  

 
  21  Power Connector 

  22  Ethernet Connector 
  

21 
 
 

 
 
 

 
22 
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3  Description 

3.4  Touchscreen Menus 

3.4.1  Menu Overview 
  Menus include text, making them largely self-explanatory. The most important points are 

described in the following. 

  Menu Group: Home Screen – No Planned Jobs 
  

 
  From this screen you can add print jobs, by pressing the ‘plus’ icon. You can also open the 

settings menu by pressing the ‘gear’ icon. 

  Menu Group: Settings Menu 
  

 
  The settings menu is accessed by pressing the ‘gear’ icon on the home screen. This menu allows 

you to access other screens which contain the following information: 

  ABOUT: Firmware for both the printer and the touchscreen. Print Information including number 
of items printed and total number of layers. Network information including Hostname and LAN 
information. 

CONTROLS: Manually move the build platform up and down. Manually turn the projector on and 
off. 

TESTS: Run a diagnostics test, or run a resin test 

SHUTDOWN: Shuts down the system. 

  Always shutdown the system using the ‘Shutdown’ button. Do not just switch off using the 
On/Off switch as the integrated file systems could get damaged. 
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  Menu Group: Add a Print 

   
  

 
   

  This menu is accessed by pressing the ‘plus’ icon on the home screen. From this menu you can 
select a print job for printing from a USB flash drive. 

  This displays each available print job on the USB flash drive and the corresponding approximate 
print times and the volume of resin required to print. 

Print jobs are selected by pressing the ‘tick’ on the right-hand side, and then pressing the ‘Add’ 
button. Several print jobs can be copied at once on the printer.   

  
Menu Group: Home Screen – Print Job Selected 

   

  

 
   

  Once a print job has been added it will display on the home screen. You can preview a 3D model 
of the print by pressing the ‘Preview’ button. 
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  The job can be deleted by swiping left on the ‘Planned Jobs’ screen. 

To begin printing press the ‘Start’ button. 
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4  Installation 

4.1  Environmental and Operating Conditions 
  – Do not place in direct sunlight 

– Do not place close to a heat source 

– Recommended operating temperature range: 17° C to 27°C (63°F to 61°F)  

– Ensure the printer is on stable, level ground. 

   

  The optimal operating temperature is 22° C (71°F) 

   

4.2  Levelling the Printer 
  Before use it is required to ensure the printer is level in order to get accurate print results.  

Use a spirit level as an aid to level the printer by adjusting the feet on the printer. 

Ensure the base is bolted to the ground that the printer is bolted to the base. 

4.3  Connecting the Power Cord 
  Connect one of the supplied power cords to the appropriate supply and connector (21).  . 

4.4  Remove the Projector Protective Cap 
  The projector is shipped with the projector cap in place. This must be removed before use. 

It is possible to remove the cap by reaching inside the print station from above. If a safety basin 
should be preinstalled this has to be removed temporarily to access the cap. See 4.7  

   

  

 

4.5  Assembling the Build Platform 
  The build platform comes pre-assembled but must be aligned to the resin tray, see section 4.10  
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4.6  Assembling the Basins 
  If the tilt blocks are not yet preassembled on the basins, the safety basin (white silicone used to 

bond the glass to frame) and the resin basins (black silicone used to bond glass to frame) must 
be assembled prior to use.  

To assemble the basin: 

1. Unpack the box containing the basin, tilt blocks, screws and pins. 

2. Lift the basin from the box by holding the aluminum rim and place it down on a clean 
paper towel. 

3. Screw the tilt blocks into the frame of the basin. Position the holes in the tilt blocks 
towards the back of the basin.  

  

 
   

  The basins are identifiable by the color of the anodization.  

The clear anodization indicates it is a resin basin and has a PTFE coating.  

The black anodization indicates it is a safety basin, with no PTFE Coating. 

DO NOT INTERCHANGE THE BASINS.  

   

  • Do not drop the box containing the basin. 
• Do not drop the basin. 
• Never touch the inside of the basin with your bare hands. 
• Never touch the bottom of the basin with sharp or pointed objects. 
• Do not place the basin with the glass flat on a surface. Always place it upside down or 

on a clean paper towel.  
• Do not rub the bottom of the resin basin to clean it. 
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4.7  Installing the Safety Basin 
   

  1. Remove the base plate of the printer by removing the four screws holding it in place. 

   

  

 
   

  2. Remove the front panel of the printer housing. This is magnetically held in place. 

   

  

 
   

  3. Carefully pick up the safety basin (white silicone), holding it gently by the frame. 

4. Slide the safety basin into position above the projector, with the tilt blocks facing the 
rear of the printer. 
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  5. Insert the pins through the tilt block to hold the safety basin in position. Ensure the rings 
are on the outside. 

   

  It is important the pins are inserted with the rings on the outside as shown below. Failure to 
do so could result in the inability to remove the pins. 

   

  

 
   

  6. Replace the front panel. 

7. Re-attach the base plate and secure into position with screws. 
  



16 

 

4.8  Installing the Resin Basin 
  1. Ensure the build platform carriage (Z-axis) is in the top position. - this can be done by 

entering the ‘Controls’ screen from the settings menu and pressing the platform ‘Up’ 
button.” 

2. Check the correct basin is being installed – black silicone to indicate PTFE coating. 

3. Pick up the basin, holding it by the aluminum frame 

4. Move the basin into position above the projection hole, with the tilt blocks positioned 
towards the rear of the printer.  

5. Tilt the basin downwards at the front and move into position under the stopping blocks. 

   

  

 
   

  6. Lower the basin so it is horizontal and resting in position. 

7. Align the holes on the tilt blocks with the holes in the frame. 

8. Insert the pins to hold the basin in place. Ensure the rings on the pins are on the outside. 

   

  It is important the pins are inserted with the rings on the outside, as shown below. Failure to 
do so could result in the inability to remove the pins. 

   

Stopping blocks 

Tilt blocks 
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4.9  Run Diagnostics Check 
  The diagnostics check is a built-in function which tests the different functionalities of the printer, 

including the projector and z-axis motor. Ensure a USB flash drive is connected prior to running 
the diagnostic checks. 

To carry out the diagnostics check: 

1. Power on the printer using the on/off switch located on the underside of the 
touchscreen. 

2. Wait for the printer to boot up. 

3. Open the settings menu from the home screen by pressing the ‘gear’ button. 

4. Select ‘Tests’ 
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  5. Select ‘Diagnostics’ 

6. Complete the checklist as directed on the touchscreen. Press the ‘Checked?’ button to 
confirm each action. 

   

  

 
   

  7. The diagnostic checks finish with a test print. During the test print the Z axis carriage 
lowers to the basin and gradually travels upwards, while the projector flashes the Loctite 
logo 

8. Once this has completed press ‘Done’ to finish. 

   

  
 Always wear UV blocking safety glasses when the projector is on 
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  Please note the z axis carriage will move up and down and the projector will turn on during the 
diagnostics checks. 

4.10  Positioning the Build Platform  
  1. Move the z axis carriage to the top position - this is done by entering the ‘Controls’ 

screen from the settings menu and pressing the platform ‘Up’ button.  

   

  

 
   

  2. Set the build platform so that the groove is matching the receiving slot. 

3. Ensure it is facing the correct direction and push into position. 

4. Screw the manual top screw down and tighten into position. 
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  5. The assembly is now in position. With one hand, raise the build platform up to the top 
position and tighten the front facing allen key screw. Do not tighten the build platform in 
the extended position, it must be at minimum extension for the calibration of the print 
tray that follows. 

  

 

4.11  Aligning the Build Platform  
  To produce accurate prints, the build platform needs to be aligned with the basin.  

To align the build platform: 

1. Ensure that the build platform and basin are clean. 

2. Move the build platform the top position – this is done by entering the ‘Controls’ screen 
from the settings menu. 

3. Loosen the 4 screws holding the ball joint so the build platform can freely move in an 
angular direction. 

   

Receiving Slot 
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  4. Lower the build platform into the lowest position - this is done by entering the ‘Controls’ 
screen from the settings menu. By pressing the ‘down’ button for three seconds the 
build platform will automatically lower to the low limit position and stop. 

5. Slowly loosen the set screw on the front of the build platform while holding the platform 
to stop it from dropping. 

   

  

 
   

  6. Move the build platform so that it lies flat and is squarely aligned with the basin. Hold 
the build platform with light (gentle) pressure inside the basin and tighten the set screw 
on the front of the build platform to fix the vertical movement of the build platform.  

   

  Be careful not to apply much pressure as this will cause Z axis misalignment. 

   

  7. Finally tighten the small Allen screws evenly around the ball joint parallel plates. The tray 
and build platform are now paired and ready for printing. Check that they are aligned on 
all corners and there is no rocking movement possible. 
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  A tray must be paired to the build platform that it will be used with. This is a procedure that 
must completed each time a new tray or build platform is used.  
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5  Loctite Operator Station PC Software 

  The Loctite Operator Station PC software is used to create print job files to be used for 
downloading to your Loctite PR10.1 Printer. 

5.1  Installing the Software 
  To install the Loctite Operator Station PC software on a computer, follow the steps below: 

The computer requires a Windows 10 operating system.  

1. Insert the supplied USB flash drive into your computer 

2. Navigate to the USB flash drive 

3. Open ‘Setup.exe’ 

4. Follow the on-screen instructions on the installation wizard. 

5. You will be prompted to request a license activation key to complete the installation. To 
do this copy the text in the box and email it to activate-lic@loctite-pr10.com   

   

  

 
   

  6. You will receive an email reply which will contain the activation code. Click on the 
‘Activation Code’ tab at the bottom of this popup and copy the activation code into the 
box. Then press ‘OK’ 
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  7. After installation it is possible to open the software. This will be found in the Programs 
menu on your computer. 

5.2  Main Screen 
  After opening the Loctite Operator Station PC software, the following screen will be displayed. 

  

 
  1. Action bar 

2. Menu bar 

3. Work area 

4. Property panels 

5. Total number of models  

6. XYZ orientation 

5.2.1 
 

Action Bar 
  Use the action bar to perform actions in the work area. 

  Below is an explanation of all the icons and their application.  

1 

2 

3 

4 

6 
5 
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Pan (shortcut: P) In this mode click the left mouse button and move the 
mouse to pan the view in the direction of mouse 
movement 

  
 
Zoom In this mode, click the left mouse button and move the 

mouse to zoom in and out 

  

 

Orbit (shortcut: O) In this mode, click the left mouse button and move the 
mouse to orbit the view around the work area 

  

 

Select Item (shortcut: S) In this mode, click the left mouse button to select a model 
in the work area for editing model properties 
and adding supports to your model. 

  

 

Move Item (Shortcut: M) In this mode, click the left mouse button to select a model 
in the work area to move it in the X and Y and Z directions. 
Hold down the left mouse button to move the model to the 
desired location on the build platform. You can also enter a 
value for movement in the pop up box. 

  

 

Rotate Item (shortcut: R) In this mode, click the left mouse button to select a model 
in the work area for rotating it in the X and Y and Z 
directions. You can also enter a value for rotation in the 
pop up box. 

  
 
Change Camera View In this mode, click the left mouse button and move the 

mouse to change the camera view of the model. 

  
 
Add Manual Support In this mode, click the left mouse button and move the 

mouse to add single support cones 

  
 
Add Grid Support In this mode, click the left mouse button to add grid 

support cones. 

5.2.2 
 

Menu Bar 
  

  

5.2.2.1 

 

File Menu 

  When opening the File menu, the below options are shown: 

  

 
  Add Model Add a model to the project 

  Open Project Open a recent project file 

  Save Project Save the work area to project file 

  Clear Project Clear all models in the work area 

  Export as STL Export all models in the work area as an STL 

  Generate Print Job Create the print job. When finished, the print view dialogue box 
appears 

  Exit Exit Loctite Operator Station PC Software. 
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5.2.2.2 
 

Edit Menu 

  When opening the Edit menu, the below options are shown: 

  

 
   

  User Preferences Display and selection options 

5.2.2.3 
 

Models Menu 

  When opening the Models menu, the below options are shown: 

  

 
   

  Calibration Model Add the default calibration model to the work area. 

5.2.2.4 
 

Tools Menu 

  When opening the Tools menu, the below options are shown: 

   

  

 
   

  Material Manager Open the Material Manager 

  Printer Manager Open the Printer Manager 

5.2.2.5 
 

View Menu 

  When opening the View menu, the below options are shown: 

  

 
   

  View Ports > Annotations When selected, different viewpoints can be chosen 

  Model View the model as a solid 

  Wireframe View the model as a wire frame 

  Support Only View the support cone(s) only 
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5.2.2.6 
 

Help Menu 

  When opening the Help menu, the below options are shown: 

  

 
  Licenses View license information 

  About View version information of Loctite Operator Station Software 

5.2.3 
 

Work Area 
  The work area is a 3D environment in which the print job is displayed. You can use the work area 

for the following functions: 

  • Align models on the build platform 

• Clone models 

• Add, modify or remove support cones. 

5.2.4 
 

Property Panels 
  There are four property panels: 

• Print job navigation 

• Print Job properties 

• Model properties 

• Support properties 

   

  These are loated on the right hand side of the home page and are accessed by clicking on them. 
The following sections describe the panels and their function. 

5.2.4.1 
 

Print Job Navigation 

  This panel allows you to navigate single supports and grid supports. 
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Remove Remove the print job navigation pane 

  
 

Refresh Refresh the print job navigation pane 

  Single Support Navigate the single support to find the best position to support the model 

  Grid Support Navigate the grid support to find the best position to support the model 

5.2.4.2 
 

Print Job Properties 

  This panel gives you access to the printer manager and the resin material database. The material 
profile of the selected resin is displayed. The material profile shows pre-determined print 
parameters suitable for the selected resin. It may be required to change these parameters to 
optimise your build depending on the geometry of the printed part. 

  

 
    

  Printer Manager Manage the available printers 

  Materials Manage the available materials 

  Name The print job name that will be displayed on the printer 

  Manufacturer Select the manufacturer of the resin that will be used for the print job 

  Product Select the resin product that will be used for the print job. 

  Initial Layers 
Number of initial layers. The intial layers are used to bond the print 
job to the build platform. 

  Layer Thickness The layer thickness (mm)  

  Rehab Time The dwell time to allow the resin to level (seconds) 

  Curing Time The cure time for each layer (seconds) 

  Retraction Height 
The retraction distance required to release the layer from the basin 
(mm) 

  Retraction Speed Up The speed that the build platform moves up (mm/s) 

  Time at Top 
The dwell time to allow the material to flow under the last cured layer 
(seconds) 

  Retraction Speed Down 
The speed that the build platform returns back to the basin after 
retracting (mm/s) 

  Light Intensity Strength The intensity of the projector (%) 
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5.2.4.3 
 

Model Properties 

  This panel gives you access to different functions and properties for modelling a print. 

  

 
  

 
Remove Remove the model from the work area 

  
 

Support Add manual support 

  
 

Grid Support Add grid support 

   Mirror Mirror selected model 

  
 

Categorised Categorise the models 

  
 

Alphabetical Place the models in alphabetical order 

  
 

Properties Window Show the properties of the models 

  

Colour 

Change the colour of the model. The colour of the model aslo 
indicates the following: 

• Red – Almost flat surface (between 175 and 185 degrees) 

• Orange – Small angled surface (between 150 and 210 
degrees) 

• White – When placing a grid support a surface can turn 
white. The white overlay shows the area that will be filled 
with support cones. 

  All Axis Locked When True, the model will be scaled by the same factor in all axis. 

  Factor The scaling factor 

  Cone Distance The distance between the grid support cones (mm) 

  Cross Support Place the grid support in a square or as a cross grid 

  Internal Support Generate support cone(s) that do not touch the build platform 

  Support Basement 
Add a support basement. A support basement makes the model 
easier to release 

  Z – Support  Generate support cone(s) on the lowest points of the model. 
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5.2.4.4 
 

Support Properties 

  This panel gives you access to different functions for creating and placing support cones. 

  

  
  

 
Remove Remove the support cone from the work area 

  

 

Save 
Save the support properties as the default properties. When new 
support cone(s) are added to the model, these settings will be 
used. 

   Apply Apply these support properties to the support cones 

  
 

Categorised Categorise the support cones 

  
 

Alphabetical Place the support cones in alphabetical order 

  
 

Properties window Show the properties of the support cones 

  Bottom Height Height of the bottom cone structure 

  Bottom Radius Radius of the bottom of the cone structure 

  Middle Radius Radius of the middle of the cone structure 

  Top Height Height of the top of the cone structure 

  Top Radius Radius of the top of the cone structure 

  Total Height Total height of the support cone 

  
Colour 

• Grey – Non-selected support cone(s) 

• Selected/Highlighted single support cone 

• Selected grid support cone(s) 

  Bottom Width Correction  

  Cone Distance Gap between support cones in a grid support 

  Cross Support Enable/Disable cross support 

5.2.5 
 

Total Number of Models 

  This shows the number of models in the work area. 

5.2.6 

 

XYZ Orientation 

  The XYZ orientation helps determine which axis to use when manipulating a model. 
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5.3  Adding a Printer to the Loctite Operator Station PC Software 
  Before creating a print job, the new printer needs to be added to the software. 

To do this follow the below instructions: 

  1. Open Loctite Operator Station Software 

2. Select Tools > Managers > Printer Manager > Add  

3. Follow the instructions on the Printer Connection Wizard.  Set the printer resolution to 
100 micron. 

  

 
  4. Select ‘next’ and follow the calibration instructions in section 6 
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6  Calibration 

  Before the printer can be used for production it must be calibrated to ensure accurate prints. 

6.1  Creating a Calibration Print 
  Follow the steps below to create a calibration print: 

  1. Following adding a printer as described in section 5.3, the following screen will be visible.  

  

 
  2. Select a resin for the calibration print 

3. Insert a USB flash drive 

4. Select the USB flash drive as ‘Drive’ 

5. Select ‘Next’ 

   

  The calibration print will be saved to the USB flash drive. Leave the calibration window on the 
software open. 

   

6.2  Printing a Calibration Print 
  Once the print job has been saved onto a USB flash drive it is ready for printing. 

  Before printing ensure the printer is prepared. See section 7.2 Preparation Before Printing 

  1. Insert the USB flash drive into the printer 

2. Select the print job from the Add a Print Menu on the touchscreen. 

3. Ensure there is enough resin in the basin.  

  Always wear gloves and safety glasses when handling resin or IPA 
  A minimum resin volume of 100ml is recommended for any print  

   

   

  4. Close the protective cover. 

5. Select ‘Print’. The print job will start. 

  The remaining print time will be displayed on the touchscreen. 
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6.3  Measuring the Calibration Values 
  When the print job has finished, the build platform is removed and the distance between the 

printed columns is measured.  

  For how to remove the build platform see section 7.3 Removing the Build  

  Ensure the build platform is free of resin and the operator is wearing the correct PPE. 

  

 
  1. Record the 4 measurements between the blocks.  

2. Enter these measurements in the software. 

  

 
  3. Select ‘back’ to regenerate the calibration print using the new values. Repeat the previous 

steps. 
   

  Carry out this procedure 3 times to fully calibrate the printer. Or once the measured values are 
160±0.2mm and 80±0.2mm 

   

  Ensure the previous build is removed from the build platform before creating another print. 
For information how to do this see section 7.3 Removing the Build 
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7  Operation 

  Once the printer has been calibrated it is possible use the printer for production. 

7.1  Creating a Print Job  
  1. Add a model(s) to the work area (the *.stl model file size can be limited depending on 

the PC hardware or memory availability. The max. recommended filesize is 40MB.  
Position the model(s) as required 

2. Select the appropriate Print Job Properties 

3. Select the appropriate Model Properties 

4. Select the appropriate Support Properties 

5. Select ‘Generate Print Job’. This will show a preview of the print. It is recommended to 
use preview to view each layer of the print and check it looks OK. 

6. Save the print to a USB flash drive 

7.2  Preparation before Printing  
  Before printing the following checks should be made: 

  1. Ensure the basin and build platform have been installed and aligned correctly. 

2. Ensure the printer has been calibrated 

3. Check the basin is not damaged and that it is clean 

4. Check the build platform is not damaged and that it is clean 

7.3  Printing  
  1. Insert the USB flash drive to the printer 

2. Select the job you wish to print. 

3. Preview the model to ensure it is correct.  

4. Shake the resin before adding it to the basin 

5. Add the resin to the basin. Ensure enough resin has been added to complete the build.  

   

  The minimum recommended resin volume is 100ml. 

Take care when adding the resin to ensure the printer area is kept clean. 

   

  6. Close the protective cover 

7. Start the print 

8. The remaining print time will be displayed on the touch screen. 
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  9. Once the print is completed, this will be displayed on the touch screen and the build 
platform will return to the up position. 

   

  

 
   

  Always wear UV blocking safety glasses when the projector is on 

7.4  Removing the Build  
  1. Ensure the build platform is in the up position. 

2. Allow the excess resin to drip into the basin.  

3. Unscrew the black knob and slide the build platform out 

  

 
  4. Wipe the build platform carefully with a paper towel so the excess resin does not drop 

on the printer 

5. Place the build platform on a flat surface. 

6. Use the included sharp metal scraper to slide under the model and remove it from the 
build platform. 
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  Be careful when using the scraper as not to slip and injure yourself 
  

 

  Take care when using the scraper so you do not damage the build platform. 

Ensure the scraper is used with the beveled face upwards. 

7.5  Cleaning the Build Platform 
  1. Wipe any excess resin away with a paper towel 

2. Use the supplied plastic scraper to remove any cured resin on the build platform. 

3. Wipe the build platform with a paper towel 

4. Wet the build platform with Isopropanol Alcohol (IPA) 

5. Use the supplied plastic scraper to scrape the build platform again 

6. Wipe the build platform to remove any remaining resin. 

   

  Always wear gloves and safety glasses when handling resin or IPA 

7.6  Cleaning the Basin 
  1. Remove the two pins holding the resin basin to the frame of the printer 

2. Carefully remove the resin basin, keeping it as level as possible while doing so 

3. Pour the resin back into the container using a funnel. Use a filter to remove any 
contamination. 

4. Spray the resin basin with Isopropanol Alcohol (IPA) and gently wipe residual resin 
away with a paper towel. 

5. Ensure the basin is clean before re-using. 
   

  Always wear gloves and safety glasses when handling resin or IPA 
   

  Do not rub the bottom of the basin to clean it. This will damage the basin. 

Do not place the resin bottom flat on a surface. Always place a paper towel underneath the 
glass. 
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7.7  Removing a Failed Print 
  If a print job has failed and resin has cured on the bottom of the resin basin, follow the 

instructions below to clean the basin: 

  1. Remove the basin from the printer 

2. Carefully pour the remaining resin from the tray into a bottle 

3. Soak the failed print in IPA for 5 minutes. 

4. Drain the excess IPA and dry using soft tissue. 

5. Put a drop of resin as close as possible to the cured resin 

6. Place the resin puller on the liquid resin. Make sure the resin puller is in contact with 
both the liquid and the cured resin 

7. Place the UV flashlight below the resin puller and shine upwards for 20 seconds 

   

  Do not look directly at the UV light, doing so could damage your eyes. Always use UV blocking 
safety glasses. 

   

  8. Carefully pull on the resin puller until the cured resin releases from the basin 

9. Remove the resin from the resin puller and dispose of it. 

10. Repeat the steps above until the basin is free of resin. 

   

  Always wear gloves and safety glasses when handling resin or IPA 

  Do not use the scraper to remove a failed print. Doing so will damage the basin.   
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8  Troubleshooting 

 
Error Correction 

The Printer does not start • Connect the printer to the power supply 

• Switch on the Printer 

• Check all internal cables 

The touchscreen does not work while printing • Wait until the print job is finished 

The build platform stops, and the motor can be heard. • Place the spindle parallel to the linear guide of 
the Z-axis 

The print is not successful  • Make sure the build platform and tray are 
properly aligned 

• It is recommended to use fresh resin, if reusing 
resin ensure it is filtered 

• Make sure the correct material is selected and 
check the settings 

• When preparing the print job on the software 
ensure it is located on the platform/bed 

• Print job slicing are sometimes generated with 
defects coming from the file. Do a scroll through 
check of the slices paying attention that the 
image is complete. 

• Check level of the printer.  
• Many resins need to be shaken before use, make 

sure to agitate the resins before printing starts 

If this troubleshooting table does not help to find a solution, please contact Henkel service. 
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9  Care and Maintenance 

   

Below are guidelines that should be followed as best practices: 

 

Daily 

• Check the printer is clean and free of excess/spilled resin. 

• Always turn off the printer using the ‘Shutdown’ button 

 

Weekly 

• Carry out a diagnostic check to check the functionality of all components of the printer. 

 

Monthly 

• Inspect the build platform for any damage such as marks or scratches 

• Inspect the resin basin for any damage such as marks or scratches. 
  

10  Spare Parts and Accessories 

   

 Description Item No. 

 Starter kit – Including: 

• Spatula 

• Resin Puller 

• Resin Curing Flash Light 

• Resin Basin 

• Build Platform 

• Nitrile Gloves 

• Spray bottle 

• Funnel with filter 

2312295 

 Build Platform 2312293 

 Resin Basin 2312291 

 EQ PR10 Starter Kit  23122 

95 
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11  Warranty 

 

 

Henkel expressly warrants that all products referred to in this Instruction Manual for (Loctite® EQ PR10.1 DLP 3D 

Printer) (hereafter called “Products”) shall be free from defects in materials and workmanship. Liability for Henkel shall 

be limited, as its option, to replacing those Products which are shown to be defective in either materials or 

workmanship or to credit the purchaser the amount of the purchase price thereof (plus freight and insurance charges 

paid therefor by the user). The purchaser’s sole and exclusive remedy for breach of warranty shall be such 

replacement or credit. 

 

A claim of defect in materials or workmanship in any Products shall be allowed only when it is submitted in writing 

within one month after discovery of the defect or after the time the defect should reasonably have been discovered 

and in any event, within (12) months after the delivery of the Products to the purchaser.  This warranty does not apply 

to perishable items, such as fuses, mix nozzles, vents, adhesive, etc. No such claim shall be allowed in respect of 

products which have been neglected or improperly stored, transported, handled, installed, connected, operated, used 

or maintained. In the event of unauthorized modification of the Products including, where products, parts or 

attachments for use in connection with the Products are available from Henkel, the use of products, parts or 

attachments which are not manufactured by Henkel, no claim shall be allowed. 

 

No Products shall be returned to Henkel for any reason without  prior written approval from Henkel. Products shall be 

returned freight prepaid, in accordance with instructions from Henkel. 

 

NO WARRANTY IS EXTENDED TO ANY EQUIPMENT WHICH HAS BEEN ALTERED, MISUSED, NEGLECTED, OR 

DAMAGED BY ACCIDENT.   

 

EXCEPT FOR THE EXPRESS WARRANTY CONTAINED IN THIS SECTION, HENKEL MAKES NO WARRANTY OF 

ANY KIND WHATSOEVER, EXPRESS OR IMPLIED, WITH RESPECT TO THE PRODUCTS. 

 

ALL WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND OTHER 

WARRANTIES OF WHATEVER KIND (INCLUDING AGAINST PATENT OR TRADEMARK INFRINGEMENT) ARE 

HEREBY DISCLAIMED BY HENKEL AND WAIVED BY THE PURCHASER. 

 

THIS SECTION SETS FORTH EXCLUSIVELY ALL OF  LIABILITY FOR HENKEL TO THE PURCHASER IN 

CONTRACT, IN TORT OR OTHERWISE IN THE EVENT OF DEFECTIVE PRODUCTS. 

 

WITHOUT LIMITATION OF THE FOREGOING, TO THE FULLEST EXTENT POSSIBLE UNDER APPLICABLE 

LAWS, HENKEL EXPRESSLY DISCLAIMS ANY LIABILITY WHATSOEVER FOR ANY DAMAGES INCURRED 

DIRECTLY OR INDIRECTLY IN CONNECTION WITH THE SALE OR USE OF, OR OTHERWISE IN CONNECTION 

WITH, THE PRODUCTS, INCLUDING, WITHOUT LIMITATION, LOSS OF PROFITS AND SPECIAL, INDIRECT OR 

CONSEQUENTIAL DAMAGES, WHETHER CAUSED BY NEGLIGENCE FROM HENKEL OR OTHERWISE. 
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